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The Tutorial is Broken up into Sections:
1. What Do I Need to Get started? GhostScript and ICC profi les
2. Setting Up Your Scribus Document
3. Color Management
4.  Formatting a Book Interior for Press with Scribus

• Creating Master Pages
• Adding and Formatting Text
• Adding Art

5.  Export Your Interior File as a Press-Ready PDF
6. How to Create Your Hardcover or Softcover File in Scribus

• Filling out the Cover Template Page
• Breaking Down the Cover Template
• How to Export Your Print-Ready PDF Cover

7. Tips and Things to Remember
8. What Do I Do Next?
9. I Need More Help!

This tutorial will offer you some advice on how to use Scribus 
to create print-ready fi les for our print program. Books can be 
prepped for Black and White, Standard Color 70 and Premium 
Color. Whether you are preparing fi les for standard color or 
premium color, the preparation is nearly identical. The only 
exception: cover templates. Be sure to get the specifi c cover 
template appropriate for your book interior type from the Lightning 
Source website. If you want to prepare a book in both color 
formats, you must prepare two different color cover fi les. 

All books going into the print program need two PDF fi les, the 
cover fi le and the interior (or book block) fi le.

There are two ways to produce a digital edition PDF presented in 
this tutorial. One way will use Scribus to directly export a PDF at a 
resolution appropriate for viewing on computers and devices. The 
other will use Acrobat Pro to optimize an existing high-resolution PDF. 
If you do not have Acrobat Pro and wish to test this process, you can 
download a trial version from the Adobe website: www.adobe.com.

The screenshots shown in the tutorial use Scribus 1.4.0 for Mac 
for the B&W book shots, Scribus for PC for the color book shots, 
and Acrobat Pro 9 and X for Mac. If you are using a different 
version of the software, some of the instructions and screenshots 
will be slightly different, but hopefully you can fi nd the right feature 
in your software version.

How Do I Get This Software?
Scribus is available for free at www.scribus.net/downloads. 
Scribus is an Open Source program that brings professional page 
layout to Linux/UNIX, Mac OS X, OS/2 Warp 4/eComStation and 
Windows desktops.

How to Prepare a Print Edition Book with Scribus
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Although you have now downloaded and installed Scribus, there are 
a few more steps you will want to take before you begin working. 

If you will be exporting a postscript fi le to produce your PDF, using 
the Print Preview function, or using any EPS fi les in your document, 
then you will need to download and install GhostScript, which 
Scribus needs in order to do these tasks. Current GhostScript 
releases of execution fi les and zipped tarballs can be downloaded 
for free from Ghostscript.com. Otherwise, you can ignore the 
warning message that will pop up when you open Scribus.

Although Scribus does come with some basic color profi les that 
are useful for producing PDFs, you may need to download and 
install professional printing color profi les, or ICC profi les, which are 
available for free from Adobe. These profi les are common standards 
in the graphics industry and will ensure that the color information in 
your press-ready PDF is consistent with standards the printer uses.

If you create or work in a Scribus document without the correct 
profi les, you cannot change the document later to correct it, so this 
is an important step.

The direct URL to download these ICC profi les is:
www.adobe.com/downloads/other-downloads.html

Under ICC profi les, choose 
<Windows> or <Macintosh>.

You will have to click through 
and accept an EULA before you 
reach the download page. Once 
there, Adobe supplies you with a 
list of included profi les in the ZIP 
package and detailed instructions 
about where to put these fi les 
after you’ve received them.

This is the list of profi les you will 
receive from Adobe. For more 
information about Scribus and 
ICC profi les, visit:

https://wiki.scribus.net/canvas/
Getting_and_installing_ICC_
profi les

1. What Do I Need to Get Started?
GhostScript and ICC profi les
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This is a basic step-by-step to help take you through all of the stages 
to laying out a book in Scribus. For your convenience, we have 
created a few template fi les for different standard book sizes to make 
your layout work easier. You can fi nd these templates in Tutorials 
and Templates for Creating Print PDFs, under Book Printing & Card 
Printing in the Publisher Knowledge Base. 

If you plan to produce both print and digital editions, you should 
set up your book fi les to print specs and then produce a digital 
book from the same fi les. For more information about setting up 
a book for print in Scribus, see the Scribus tutorial in the Tutorials 
and Templates for Creating Print PDFs section.
Open Scribus. Then in the File pull-down menu, open the template. 
Make sure you are using the right template for your book size.
Click the Windows pull-down and open the Properties window. 

2. Setting Up Your Scribus Document

Anatomy of a book page 
•  The outside edge is the Bleed Line. It may appear black when the 

page is selected in Scribus. Any art or graphic that is intended to 
go off the edge of the page must line up with this line.

•  The red line just inside the Bleed Line is the Page Edge or 
Trim Line. When the book is produced, the pages will be cut at 
approximately this line. Text and art that doesn’t “bleed” should 
not go past it. Color books must be submitted to the correct bleed 
size, regardless of content.

•  The blue line inside the Page Edge is the Safe Area or Live 
Area. Anything in this area should be safe when pages are cut. 
Anything that doesn’t bleed should be well inside this margin 
and should never go outside of it. For a digital edition book 
where no printing will occur, the size of this margin is more of 
a suggestion than a hard-and-fast rule, so it can be adjusted to 
better fi t your content. For print, this is not negotiable.

•  The black line in the center is the Gutter and is the inside spine 
of the book.

•  The black dotted line near the gutter is called the Gutter 
Allowance. For full color books, the area between the Gutter 
Line and the Gutter Allowance line should be free of any art, 
graphics or text. This is where the pages are glued together 
and into the book cover. The glue does not adhere well to color 
ink, so it is very important to keep this area free from any printing 
items. Gutter Allowance is important for color hardcover and color 
softcover perfect bound books. It is not necessary for black-and-
white hard- and softcover books or any saddle-stitched books.
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Grayscale vs Full Color Printing
There is little to no difference between grayscale and full color 
press-ready export settings when you have completed your 
project and are ready to produce your PDF. What makes them 
different is the color output intent you should set before you 
begin working in your fi le.
To choose your output intent, open your Scribus program 
preferences, not your Scribus document set up. Scroll down the 
left-hand options and choose PDF Export. 
Open the Color tab: 
• choose Printer for a full color export
• chooseGrayscale for a grayscale export.
Now you’re ready to get to it!

2. Setting Up Your Scribus Document (continued)
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3. Color Management
Once you are ready to export, make sure the book is set up as 
you would like it. Open Document Setup from your File pull-down 
menu, make sure that Color Management is turned on (if you 
are printing in full color), and that you have selected U.S. Web 
Coated (SWOP) v2 as your document CMYK and printer profi les. 
You must have Color Management activated and color profi les 
assigned in order to export a PDF/X-1a or X/3 for press.
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4. Formatting a Book Interior for Press with Scribus 
Creating Master Pages

Master Pages allow you to place borders, text and other 
information once and it will appear on all the pages you select.

Go to the Insert pull-down menu and select Image Frame. 

Click and drag to place frame for master page image. You can set the 
frame size with the Properties window using the X,Y,Z tool or you can 
manually resize it by clicking and dragging the blocks on the box.

Double-click on the box and select the graphic to import.

Use the Image tool in the Properties window to size the image 
to the box simply by clicking the Scale to fi t Frame Size button. 
Tick the checkbox for Proportional to be sure the graphic is not 
stretched.

If you missed where to fi nd the Properties window in the beginning of 
this tutorial please click the Windows pull-down menu and open the 
Properties window. It will be used often.

Once you have the page set the way you 
would like, go to the Page pull-down menu 
and select Convert to Master Page. Name 
and save the master.

Click on the page(s) 
you wish to convert to 
masters (hold the shift 
key down), pull-down 
the Page menu, and 
select Apply Master 
Page. All the pages you 
chose will autoformat.
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To place simple text, open the fi le with your text and select the text 
you want to place. Right-click and choose Copy. Go back to your 
Scribus fi le and click on the fi rst page inside the text area, right-click 
on it and choose Paste to import and place all the text you selected.

It will not be formatted but it will all be there.
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4. Formatting a Book Interior for Press with Scribus 
Adding and Formatting Text

Now format the text. Open the Text menu in the Properties window.

Right-click to select all the text and set the basic font and size for 
the body text.

Justify text by selecting it all and clicking the Left Justify Text box in 
the menu.

Once you have the body text adjusted, you can go through and set 
the headers by selecting them and setting the size and font with 
the Text tool in the Properties window.

Remember, the body text will be small so use a font that is easy to read 
without many fl ourishes. Industry standard for size is 10pt to 12pt.

If you have a lot of text to format, you may want to set the body and 
header styles. Click the Edit pull-down menu and select Styles. In 
the window that opens you can set the Headers (Character) and 
the Basic Body text (Paragraph). Once those are set, select the text 
to be modifi ed and choose the style that will now appear under the 
Style Settings in the Text Tool to convert it. It is simple to navigate 
through the menu and can save you some time in the long run. 

Things to avoid as you 
style text in your document:

• Widows: One single word 
or line at the bottom of a 
column of text

•  Orphans: One single 
word or line at the top of a 
column of text

•  Hyphens between columns 
of text 
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1.  To add art or graphics, fi rst add an Image Frame by clicking 
the Insert menu and choose Insert Image Frame. 

2.  A tab will attach to the cursor. Click and drag to make a box to 
place the art in. 

4. Formatting a Book Interior for Press with Scribus 
Adding Art

3.  Before moving the text out 
of the way of the Image 
Frame, be sure it is unlocked. 
Simply double-click the text 
and make sure the Is Locked 
option is not checked.

4.  Then using the arrow tool 
from the top menu, resize the 
text box and size the Image 
Frame.

5.  When it is arranged, double-click on the Image Frame and select 
the image to be placed.
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The selected graphic will be placed in the box and just needs to be 
sized using the Image tab in the Properties window.

Simply clicking Scale to Frame size, the graphic will fi ll the frame. 
If the Proportional option is selected, the graphic will remain 
proportionate. If the graphic is larger in width or height, then can 
proportionally fi t, it will fi t to the smaller measure.

Continue this with each graphic to place them all.

4. Formatting a Book Interior for Press with Scribus 
Adding Art (continued)
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5. Export Your Interior File as a Press-Ready PDF
Choose the File pull-down menu, then Export, then Save as PDF. 
A Prefl ight Verifi er window may open that will allow you to review 
any errors that appear. Make any adjustments you need to the 
book before continuing. Make sure your Prefl ight Verifi er Profi le is 
set to PDF/X-1a or PDF/X-3. 

When you are ready to export, click Continue from this window and 
set the following specifi cations in the next series of windows.

Under the General tab:

Make sure All Pages is selected, 
Compatibility is set to PDF/X-
1a or PDF/X-3, and Maximum 
Image Resolution is checked 
and set to 300 dpi.

Under the Fonts tab:

Make sure All Fonts are 
Embedded.

Under the Color tab:

Make sure Output is set to 
Printer and Convert Spot Colors 
to Process Colors is checked.

Under the Pre-Press tab:

Check Use Document Bleeds. 

Please DO NOT include any 
printer marks in your fi nal export.
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To get the correct fi le for your book cover, fi ll out some details and 
Lightning Source will generate a template for you. 

Go to: https://myaccount.lightningsource.com/Portal/Tools/
CoverTemplateGenerator

•  13-digit ISBN: Enter all zeroes [000-0-00000-000-0]. Do not 
enter a real ISBN, even if your book has one.

•  Publisher Reference Number: Optional fi eld for your own 
stock code if you use one.

• Trim Size: Select your book size.
•  Interior Color and Paper: Make your choice here. 

We are currently phasing out our Standard Color on 50lb 
paper option. Black and white is printed on 50lb paper. Color is 
printed on 70lb paper. Be sure to select the correct interior type 
and have an accurate total page count so the spine width can 
be calculated for your template.

•  Binding Type: Case Laminate is Hardcover. Perfect Bound is 
Softcover. Saddle Stitch is Softcover for very low page count 
books under 48 pages, and is only available in Premium Color 
for certain sizes. 

•  Laminate Type: Select your choice.
•  Duplex Cover: We currently do not offer duplex covers. 
•  Page Count: Your fi nal page count here in a number divisible 

by 2, 4 or 6. Your page count does not include the cover. For 
more information about page counts, see the Page Count and 
Signature sections of Tips and Things to Remember, at the end 
of this tutorial.

•  File Type: Select PDF.
•  Email: Your email address. 
•  Optional Information: Leave them as they are.
•  Click Submit: The template will be generated and emailed to you.

6. How to Create Your Hardcover or Softcover File in Scribus
Filling out the Cover Template Page
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What are all of these colors? Regardless of what type of cover you are producing, the guides will look the same, just in different 
proportions, and the book data will appear in different places depending on what format it is.

• Pink Boxes show the Safe Area. No text, logos, borders, boxes, or barcodes should extend outside this area. Each part (back 
cover, spine, and front cover) has a safe area.

• Blue Boxes show the Bleed Area. Any background color, pattern, gradient or image that you wish to extend to the edge of your 
cover should extend out to, but not past, the Blue Box.

• White Space shows the Template Area. None of your cover elements should be in this area. Do not alter any of the information here.
• Black horizontal and vertical crops are the Trim and Fold Marks. These mark the spine folds and cover turn-in folds. The cover is 

6. How to Create Your Hardcover or Softcover File in Scribus
Breaking Down the Cover Template

Sample Cover Template

turned in and pasted 
to the back of the 
cover board, under 
the book’s endsheets. 
The endsheets help 
secure the book’s 
interior to the covers.

• The Barcode inside 
the barcode box 
on the back cover 
should be deleted 
or covered. Lightning 
Source will assign 
and place a barcode 
for you. If you do not 
remove the sample, 
your cover will be 
rejected. If you would 
like to designate 
where the barcode 
should be placed, 
delete the placeholder 
barcode information 
inside the box, and 
then move the box to 
a new location in the 
safe area.
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Producing a cover fi le in Scribus is easy. Let’s start by 
making sure everything you need is available. Once 
Lightning Source emails you the cover template, 
open it up in any image editing program, and take a 
look at it. Where the fi le data is on the template will 
be different depending on what type of cover you 
are building, but it will be at the bottom somewhere. 
Double check that the book interior specs, cover size, 
and type of book printing are correct. In this area it 
will also give you a document size. Make note of this 
as you will need it later. Then choose Save As... (in 
whatever program you have opened the fi le in) and 
save the fi le as a JPG.

Now open Scribus and this handy window will come up. Set the 
specifi cations as follows:

Document Layout: Single Page
Size: Custom
Orientation: Landscape
Width and Height: Set the New Document Size to match the 
document size taken from the template. In this case...it’s 23” x 
14”. If your displayed units are not in inches, set your default unit 
under Options.
Margin Guides: Set to 0
Bleeds: Set to 0
Then click OK.

6. How to Create Your Hardcover or Softcover File in Scribus
Breaking Down the Cover Template (continued)

Document info
Document 23”X14”
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Now the window will open up with the fi le size all set for 
the template to be placed.

Go to the Insert pull-down and select Insert Image 
Frame. You can click and drag to make it the same 
size as the page, or you can use the X,Y,Z tab in the 
Properties window to set it exactly to the document size, 
in this case 23”X14” (preferred). 

Then double-click the frame to place 
the template you saved as a JPG. As 
you can see, this is similar to placing 
art in the interior fi le.

Remember to click Scale To Frame 
Size and tick Proportional to fi t the 
template properly.

Now you can right-click on the 
template and lock it in place. Once 
it’s locked it will stay in place and be 
easy to work on top of.

Make a new image box, same as 
above, fi tting it to the bleed lines, 
and then place your cover art. You 
must still see the printer’s crop 
and fold marks and the other cover 
information.

Using the same methods, add the 
spine and back cover art if they are 
separate fi les.
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6. How to Create Your Hardcover or Softcover File in Scribus
Breaking Down the Cover Template (continued)
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To add text to the cover, select the Insert
pull-down menu and select Insert Text 
Frame. Click and drag your cursor to make 
a frame where you want the text to go.

Then choose the Type Tool from the menu 
on the top (it is a capital A). Type what you 
need into the box and then use the Text tool 
form the Properties menu on the right, to 
adjust the font, size, etc.

6. How to Create Your Hardcover or Softcover File in Scribus
Breaking Down the Cover Template (continued)
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Be careful where you place your text; make sure it is easy to read. 
If you are losing text in the background, you can change the color 
or add a drop shadow with the Text tool in the Properties window.

You can add text to the back cover and the spine as well. To turn 
the text so it fi ts properly on the spine once you have it typed 
in and looking as you would like it, use the X,Y,Z tool in the 
Properties menu to Rotate to 270º.

Once you have everything where you want it, you are ready to 
produce the PDF fi le.
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The method and settings for exporting a cover PDF for press 
are the same as exporting your multi-page interior fi le.

Open Document Setup from your File pull-down menu, make 
sure that Color Management is turned on (if you are printing 
in full color), and that you have selected U.S. Web Coated 
(SWOP) v2 as your document CMYK and printer profi les. You 
must have Color Management activated and color profi les 
assigned in order to export a PDF/X-1a or X/3 for press.

To export, use the File pull-down menu, select Export, and 
then Save as PDF. If your Prefl ight Verifi er window opens, 
make sure your profi le is set to PDF/X-1a or X/3. Make 
any adjustments you need to the book before continuing. 
Correct all errors before exporting.

6. How to Create Your Hardcover or Softcover File in Scribus
How to Export Your Print-Ready PDF Cover

Under the General tab:

Make sure All Pages is selected, 
Compatibility is set to PDF/X-
1a or PDF/X-3, and Maximum 
Image Resolution is checked 
and set to 300 dpi.

Under the Fonts tab:

Make sure All Fonts are 
Embedded.

Under the Color tab:

Make sure Output is set to 
Printer and Convert Spot Colors 
to Process Colors is checked.

Under the Pre-Press tab:

Check Use Document Bleeds. 

Please DO NOT include any 
printer marks in your fi nal export.
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Specifi cations
Page count: Please note that the interior fi le you export should 
be an odd number of pages, one page less than the page count 
number you entered into the cover template generator. The 
printer requires that the fi nal page of a book interior be absent 
on receipt, because they add the last page to your fi le during 
premedia setup. They need the space to place their internal 
production tracking barcode. This barcode is used to scan the 
book interior during book binding, to be sure that the correct 
cover is put on the correct book interior. (This production barcode 
is unrelated to and should not be confused with any ISBN or 
UPC barcodes on the outside covers.)

Signatures: Depending on a book’s fi nal trim size, the fi nal page 
count of a book should be evenly divisible by 4 or 6. Pages are 
printed, folded, and sewn in bundles of four or six pages, called 
signatures. Poorly planned signature counts will result in extra 
blank pages at the back of the book to fi ll out the correct count. 
The following table summarizes whether a book size has a page 
count divisible by 4 or 6.

Size Divisible By

6.14 x 9.21 and smaller 6
6.69 x 9.61 and larger 4

For example, when doing an 8.5” by 11” B&W interior book, you might 
have a fi nal page count of 120 pages. Enter 120 for the page count 
when using the cover template generator on Lightning Source’s site. 
Then submit your book interior PDF fi le with 119 pages.

7. Tips and Things to Remember
•  All Images must be CMYK for color format, or Grayscale for B&W format, 

and all at a 300dpi/ppi resolution.
•  DO NOT use transparency in your images or JPEG2000 compression in 

any linked or embedded JPEG art fi les, even if it reduces your fi le size. 
  Apple’s iPad and iPhone cannot display images using JPEG2000 

compression or fi les with transparency attributes.
•  Text should be 100% black (CMYK values of 0% Cyan, 0% Magenta, 0% 

Yellow, and 100% Black or Key). Other black elements should NOT be built 
in “Registration” black; use “Rich” black (C 60 / M 40 / Y 40 / K 100).
CMYK total value should NOT exceed 240%. 

•  Header fonts should be 24pts to 14pts, Body Fonts 10pts to 12pts.
•  Avoid leaving a single word at the end of a paragraph or a single line at the 

top or bottom of a column of text.
•  Embed all fonts (all font families used, including both screen and printer).
• For best results, text should be at least 0.25” from trim edges of the book. 
• It’s best to leave at least 0.5” between the text and the edge of the spine.
•  For covers of books less than 48 pages, do NOT place text on the spine.
•  Covers should be produced on a single document page, wide enough to 

encompass the front, spine and back of the book, along with bleed on all 
sides. Use the template you received via email from the Lightning Source 
cover template generator. Covers not built on this template will be rejected.

•  Do not add information such as crop marks, web-press comments, etc.
•  The barcode box size should not be scaled any smaller than it already 

appears by default on the template.
•  You can place a barcode box anywhere on your back cover that you prefer. 

Leave the box blank white. The printer will add the barcode.
• DO NOT use PDF/A profi le compliance for your exported PDF.
•  DO NOT lock or use security settings in your exported PDF. This means 

imposing password protection as well as turning off the ability to copy/paste 
or print from the PDF.
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8. What Do I Do Next?

Once you have fi nished producing your interior book block and 
cover fi les, you’re ready to upload! 

Log into your DriveThru account, and go to your Publisher Hub on 
the Publish page. If you have not already set up a title record, go 
to TITLE MANAGEMENT/Set up a new title to do so. 

If you have any questions or need more information about how to 
proceed with fi lling out this form, you may fi nd it helpful to consult 
Set Up a New Title & Edit a Title, located in the Publisher Knowledge 
Base, under Title Management/Digital Titles, and I am ready to 
make my title a POD. Where do I start?, under Book Printing & Card 
Printing/Book Printing.

After a successful upload of your press-ready PDFs, you will need 
to order a proof. Once you receive, review, and approve your 
printed proof, you will be able to activate your title for live sale! 
How exciting!

9. I Need More Help!

Your publisher service rep is not really an expert on digital layout, 
so chances are slim that they will be able to answer questions 
not answered in this tutorial. However, please do email us your 
questions anyway so we can help you fi nd an answer. This helps us 
improve this tutorial, so it answers more questions for everyone.
If you have decided that you don’t care to do your own fi le layout, you 
can fi nd people with professional skills and contract them to create 
your print fi les. The cost of this work depends on how much of the 
work you do yourself before handing it over. You can fi nd freelance 
layout professionals at sites like www.upwork.com.

We can also recommend someone for layout if you would like. 
Please contact Publisher Services for details.
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